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1. Introduction   

Thank you for choosing the Em50. This data logger is
designed and suited for field research and commercial
agriculture. This manual will explain the Em50’s capa-
bilities and functions.

NOTE: The Em50R model contains a data radio module.
Except where specified, all functions and specifications relating
to the Em50 also relate to the Em50R.  

Contact Information
If you need to contact Decagon about your Em50:

• Call us at: 1-800-755-2751 (toll free; US/Can-
ada only) or 1-509-332-2756

• Fax us at: 1-509-332-5158

• E-mail us: at ECH2OHELP@decagon.com

You can also send feedback to Decagon using Utility’s
“Send Feedback to Decagon” feature. See Appendix B
for more information.

Warranty
All Decagon products have a 30-day satisfaction guar-
antee and the Em50 has a one-year warranty.
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Seller’s Liability
Seller warrants new equipment of its own manufacture
against defective workmanship and materials for a
period of one year from date of receipt of equipment
(the results of ordinary wear and tear, neglect, misuse,
accident and excessive deterioration due to corrosion
from any cause are not to be considered a defect); but
Seller’s liability for defective parts shall in no event
exceed the furnishing of replacement parts F.O.B. the
factory where originally manufactured. Material and
equipment covered hereby which is not manufactured
by Seller shall be covered only by the warranty of its
manufacturer. Seller shall not be liable to Buyer for
loss, damage or injuries to persons (including death),
or to property or things of whatsoever kind (including,
but not without limitation, loss of anticipated profits),
occasioned by or arising out of the installation, opera-
tion, use, misuse, nonuse, repair, or replacement of
said material and equipment, or out of the use of any
method or process for which the same may be
employed. The use of this equipment constitutes
Buyer’s acceptance of the terms set forth in this war-
ranty. There are no understandings, representations, or
warranties of any kind, express, implied, statutory or
otherwise (including, but without limitation, the
implied warranties of merchantability and fitness for a
particular purpose), not expressly set forth herein.

Specifications
Input Ports: 5, 12-bit analog or 32-bit digital 
Port type: 3.5mm “stereo jack” connector
Data Storage: 1MB (36,800 scans on all 5 ports)



Em50/Em50R Operator’s Manual
1. Introduction

3

Memory type: Non-Volatile Flash 
Battery capacity: 5 AA Alkaline or Lithium batteries
Enclosure: Weatherproof, impact and UV-resistant
polymer
Enclosure rating: IP55, NEMA3R
Operating environment: 60° to -40°C, up to 100%
RH
Communication: Dedicated serial port 3.5mm stereo
jack for use with the Decagon Serial Cable Adapter
(SCA).
Data Radio (Em50R models):
902 - 928 MHz ISM North America
915 - 928 MHz ISM Australia, New Zealand, Israel
2.4 GHz ISM Worldwide 
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2. The Em50/Em50R      

Em50/Em50R System Overview

Introduction

The ECH2O System is made of data loggers, sensors,
telemetry, and software that help you measure soil
moisture and other environmental parameters accu-
rately and cost effectively. Decagon’s innovative sen-
sors are the heart of the system. Decagon also
designed the system to be very easy to use (no pro-
gramming needed). 

About the Em50. The Em50 is a 5-port, self-con-
tained data logger especially suited for field research
and commercial agriculture. The Em50 comes in two
models: the Em50, and the Em50R. Both devices are
housed in a weather-resistant enclosure, making them
suitable for long-term outdoor operation. 

The Em50R includes a spread-spectrum radio teleme-
try module. The radio module is available in long-
range 900 MHz and world-ready 2.4 GHz frequencies.
Use the telemetry in a low-power transmit mode or a
higher power two-way mode. (See Chapter 6 for more
information on telemetry.)

Em50 Compatible Sensors

You can use the Em50 to measure the following
ECH2O System sensors: 
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• EC-5 ECH2O Soil Moisture Probe with 5 cm
sensor length. 

• EC-10 ECH2O Soil Moisture Probe with 10 cm
sensor length. 

• EC-20 ECH2O Soil Moisture Probe with 20 cm
sensor length.

• ECH2O-TE volumetric water content/tempera-
ture/electrical conductivity sensor.

• EC-TM water content/temperature.

• ECRN-50 Rain Gauge with 1 mm tip resolu-
tion. 

• ECRN-100 Rain Gauge with .01 inch tip resolu-
tion.

• ECT Soil and Air Temperature Sensor. 

• LWS Dielectric Leaf Wetness sensor.

• G1 Drain Gauge.

• ECH2O Pressure Switch.

• EHT Temp/RH (temperature/relative humid-
ity) sensor.

• PYR Solar Radiation.

Software

The Em50 gives you three software options for work-
ing with your hardware and collected data. Choose
one or more packages to fit your needs. You can
download the latest versions of these programs at
www.decagon.com/ech2o/software.
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ECH2O Utility. ECH2O Utility is free software that
is included with your purchase. It provides a simple
way to connect to and configure your loggers. The
ECH2O Utility makes downloading and processing
your measured data fast and easy. 

• Connect to Em50 loggers directly or with radio
telemetry.

• Set all logger configuration parameters with
visual controls. 

• Make real-time sensor measurements (scan sen-
sors). 

• Create Excel or text files with raw or processed
data. 

• Create configuration and data files for use with
ECH2O DataTrac. 

ECH2O DataTrac. ECH2O DataTrac is the premier
ECH2O System software designed to help you orga-
nize and visualize your measurement data. DataTrac is
particularly useful if you have several data measure-
ment sites and don’t want the hassle of managing the
data after each download. It is the only ECH2O soft-
ware that lets you easily apply custom calibration to
sensor data. DataTrac comes with the Em50 system as
a 30-day trial version. If you would like to continue to
use DataTrac, contact Decagon to purchase a
DataTrac license. Along with most of the features of
ECH2O Utility, DataTrac also offers: 

• Powerful charting engine shows data graphically. 

• Simple table view allows data manipulation. 
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• View summarized data based on chart period. 

• Automatically organize and store data for each
Em50 logger in a device directory tree. 

• Apply sensor-specific calibration to data. 

• Create reports with chart and summary data.
Print or save as PDF. 

• Easily transfer data and configuration to other
DataTrac users. 

ECH2O Utility Mobile. ECH2O Utility Mobile is
designed to bring the usefulness of ECH2O Utility to
Windows powered mobile devices or handheld com-
puters (PDA). Use this software and your PDA in the
field instead of your expensive laptop. This software
will configure your logger, download data, and make
real-time sensor measurements. Like the desktop ver-
sion, ECH2O Utility Mobile allows you to: 

• Connect directly or with radio telemetry to
Em50 loggers.

• Set all logger configuration parameters with
visual controls. 

• Make real-time sensor measurements (scan sen-
sors). 

• Creates configuration and data files for use with
DataTrac. 

• Creates data files for use with ECH2O Utility. 

ECH2O Utility Mobile works with most Windows
PDAs, including the HP iPAQ. Decagon Recom-
mends using the Juniper Systems Archer field PC



Em50/Em50R Operator’s Manual
2. The Em50/Em50R

8

(available from Decagon). This ultra-rugged mobile
device is designed to work in field conditions where
typical PDA hardware will fail. Please see the ECH2O
Utility Mobile manual for more information on system
requirements to use your PDA with the ECH2O Sys-
tem.

The ECH2O Check. The ECH2O Check is a simple
hand-held readout for the ECH2O probes. It works
with the EC-5, EC-10, and EC-20 volumetric soil
moisture sensors. It displays single sensor readings on
a large-digit LCD. The ECH2O Check is well suited
for use during sensor installation, or to check the
function of installed probes while troubleshooting. 

Em50/Em50R Data Logging 
Scheme
The Em50 will not make sensor measurements until
you set a measurement interval. You also need to con-
figure the Em50 ports with the type of sensor plugged
into each port. You can set these values using the soft-
ware described in the next chapters.

Em50 Measurement Interval
The measurement interval controls how often data is
recorded in the Em50’s internal data storage. The
interval you choose applies to all 5 ports on the Em50,
therefore, it is not possible to have one port measuring
sensors more or less frequently than another port. 

The measurement interval works relative to the
Em50’s internal real-time, 24-hour clock. For example,
when choosing a measurement interval of 120 min-
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utes, the Em50 will store data every two hours, on the
hour. The resulting data will show sensor measure-
ments hourly at 12:00 a.m., 2:00 a.m.,..., 10:00 p.m.
Choosing a measurement interval greater than 720
results in one set of data stored per day. For most
applications, a measurement interval of 60 or 120 min-
utes is appropriate.

NOTE: Setting the Em50 measurement interval to zero
turns off sensor measurement and data storage. 

For most sensor types, the Em50 makes a measure-
ment from each of the 5 sensor ports every 60 sec-
onds, regardless of the measurement interval value.
When the Em50’s internal clock reaches the user-pro-
grammed measurement interval, the Em50 stores the
average of all the 60-second sensor readings taken
since the last storage interval. Therefore, if you set the
measurement interval to 60, the Em50 will actually
store an average of the past 60 sensor readings. If you
choose an interval of 1440, the Em50 will store one
value that represents the average sensor value for the
entire 24-hour period.

Data Storage Format

The Em50 stores “raw” data for each sensor. The
stored values are not in millivolt units. See Chapter 9:
Compatible Sensors, for equations to convert raw data
to meaningful sensor values.
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How the Em50 Stores Data  

The Em50 stores data for all five sensor ports for each
measurement interval. If no sensor is connected to
one or more of the logger’s ports, the Em50 will store
a “0” for that port. The Em50’s data memory is non-
volatile flash. Removing the batteries or performing a
system reset will not erase your data. 

Data Storage Size  

The Em50 stores more than 36,800 data scans. When
the logger has filled its data memory, it begins over-
writing the oldest data in the memory. 

Measurement Span  

Depending on the set measurement interval, the
Em50 can read for several weeks to several years
before its memory has filled. You can determine how
many days of data your Em50 will hold by dividing the
size of the data memory (36,864 scans) by the mea-
surement interval. For example, an Em50 set on an
hourly measurement interval will store 1,500 days, or
about 4 years, worth of data. An Em50 set to five min-
utes will store data for 125 days, or about four months.
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3. Setup and Installation 

Installing the Batteries

The Em50s are shipped with a new set of AA alkaline
batteries. Open the case and install the batteries in the
proper orientation as indicated in the battery locations.
After installing the batteries, press the silver Reset but-
ton located directly above the batteries.

NOTE: Installing or changing the batteries in your Em50
resets the internal real-time clock. You must connect to your
Em50 using any ECH2O System software to reset the logger’s
clock. If you don’t set the logger’s clock, the time and date associ-
ated with each measurement will be incorrect.
 
The Em50 is powered by 5 AA-size Alkaline batteries.
With the radio disabled, a set of Alkaline or Lithium
batteries can last for several years. The battery life for

batteries Reset
button

Status
light
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radio-enabled Em50Rs varies depending on how the
radio is setup. (See Chapter 6: ECH2O Radio Teleme-
try). For example, with the radio operating in “Con-
firmed Delivery Transmit” mode, the batteries should
last over a year. However, in the two-way radio modes
more battery power is used and the battery life
decreases. 

You can check the battery level status when the Em50
is connected using any ECH2O software. When the
battery life indicator shows that your Em50’s batteries
are less than 5%, you should replace them.

The Status Light & Reset Button   
When you install the batteries and program a measure-
ment interval, the status light (shown in the previous
picture) will blink. This light indicates the logger’s cur-
rent status.

• If the light does not blink, the logger is not
powered (batteries are dead) and/or is not set to
log any data.

• A single blink every 5 seconds means the logger
is logging data.

• A slow on-off blink indicates the logger is
connected to an active serial port.

• A rapid continuous blink (system error) indi-
cates that the system date and time are set incor-
rectly. This rapid blink will only last for 2
minutes to prevent rapid battery drain.
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If your datalogger’s operating system freezes or
becomes unresponsive, press the reset button next to
the status light.    

NOTE: The internal data storage of the Em50 is non-vola-
tile, so you will not lose data if you remove the batteries or press
the Reset button.

Installing Software
The included ECH2O Utility and DataTrac software
allow you to collect and manage data from your
device. 

NOTE: This manual documents ECH2O Utility. Most
tasks that can be performed using the ECH2O Utility can also
be accomplished using DataTrac or ECH2O Utility Mobile.
For more information about using DataTrac or ECH2O Util-
ity Mobile, please refer to their respective manuals. 

To install ECH2O Utility or DataTrac software, place
the CD in your CD drive, and wait for it to auto-
launch. If it doesn’t launch, go to My Computer, select
your CD drive, and click on the “setup.exe” file.

Occasionally, new versions of ECH2O System soft-
ware will become available on Decagon’s website.
They can be accessed at www.decagon.com/ech2o/
software.

You can find your current software version in the
“About” option of the Help menu in the ECH2O Util-
ity and DataTrac. If you are connected to the internet,
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select “Check for Updates” in the Help menu to see if
there is a newer version available.

Configuring the Em50/Em50R in 
the ECH2O Utility
Before field installation, the Em50 needs to have cer-
tain parameters set, such as name, date and time, mea-
surement interval, and communication mode. Also,
the radio-enabled Em50R will not respond to radio
contact until properly configured to do so. To config-
ure the logger, do the following: 

1. Open the ECH2O Utility program.

2. Plug the 3.5 mm connector of the RS-232 cable
(included with your Em50) into the logger’s COM
port, and plug the 9-pin connector into the serial
port of your computer. 

 

Port diagram

serial
communication
port
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3. At the top of the screen, select the appropriate
COM port from the “Connect Via” drop-down
menu, then click on the “Connect” icon.

4. Once you have successfully connected, the menus
on the main screen will become active. 

5. At the device setup screen that appears, click on
the various fields to enter a name for your logger
and choose sensor types for each port.

For the Em50R, select the radio settings you plan
to use. (See Chapter 6: ECH2O Radio Telemetry).
Click on “Apply” to save the changes. 

6. Press the “Disconnect” icon when finished.

Field Installation 
The Em50 will serve as a collection station for up to 5
sensors. The Em50 is compatible only with sensors
made by Decagon specifically for use with the Em50s,
such as the ECH2O water content probes, rain gauge,
temperature sensors, etc. To install the Em50 and sen-
sors, do the following:

1. Install your sensors as directed in the respective
sensor’s manual.

2. Plug the sensor’s jack firmly into the Em50 input
port. 

3. On the top and bottom of the Em50, there are
two loop-holes. Use these to fasten the Em50 to a
mounting post using the included zip-ties or a sim-
ilar fastener. Make sure it is installed in an upright
position, with the 5 input ports underneath. In this
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position, rain and spray are shed by the enclosure
and drip off without affecting the contents of the
Em50 enclosure.

Cautions
When you install the Em50/Em50R, remember:

• Do not immerse the Em50 in liquids.

• Make sure to install the Em50 upright to reduce
the possibility of water entering the Em50
enclosure. 

• Do not install Em50R radio-enabled loggers
near large metallic objects, as these can attenuate
the radio signal. 

• If the Em50R is mounted to a metallic post, be
sure to use an antenna extension cable to mount
the antenna to the top of the post. This will
maximize the transmit range of the Em50R.

• There is a higher risk of lightning damage to the
Em50 if using probes with extension cables.
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4. Using the ECH2O Utility

Introduction
ECH2O Utility provides a user-friendly interface for
configuring and downloading the Em50 logger. After
installing the program (see Chapter 3: Setup and
Installation for instructions), launch the program. You
will see the main screen:

The ECH2O Utility Main Screen

Here you can set all logger configuration parameters
with visual controls. At the top of the program win-
dow is a toolbar for interacting with the Em50. To the
left is a battery indicator. To the right is the “Connect
Via” menu, where you can select a COM port; the
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Connect button (which displays “Disconnect” when
you are connected to an Em50); the Download but-
ton, which downloads data saved on the Em50 onto
your computer; and the Scan button, which scans all
of the sensors connected to each port on the Em50,
and returns a real-time reading. These functions will
be described in detail further in this chapter. Below are
the most common tasks that can be performed with
the ECH2O Utility, explained in detail.

Common Tasks

Configuring the Em50/Em50R
The Em50 doesn’t require any programming. It does
have several parameters that control identity and func-
tion. To change a parameter, connect to your device,
change the desired parameter, then click “Apply” to
send the parameter changes to your device. Here is a
brief description of each:

Name. Each Em50 device should have a unique
name. The default name is the unit’s serial number.
You can change this to any legal name you want. A
legal device name uses upper and lower case letters,
numbers, underscores, hyphens, and most upper-ascii
characters. Spaces and most punctuation are not legal
name characters. ECH2O Utility prevents you from
choosing a name containing illegal characters.

Serial Number. When set in the factory, this is a read-
only value.
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Radio Settings. Only devices that have a radio mod-
ule will support these options (Em50R, DataStation).
See Chapter 6: ECH2O Radio Telemetry for more
information on using the radio settings.

Measurement Interval. Em50 loggers allow you to
select a measurement interval between 0 and 1440
minutes. A measurement interval of zero (0) stops the
logger from making measurements.

Port Sensors. The Em50 requires you to identify the
sensor type for each of the five sensor ports.

Downloading Data
Once the Em50 is properly configured and installed, it
will begin taking and storing measurements. Data can
be downloaded in two ways. The “Download New”
option downloads data recorded since the last down-
load. “Download All” will download all data currently
stored in the Em50. The Download button on the
toolbar downloads only the new data.

To download data, do the following:

1. Use the RS232 serial cable to connect it to your
computer. 

2. Choose “Direct on” the appropriate COM port
from the “Connect Via” drop-down list and press
the “Connect” button. If you encounter connec-
tion errors, please see Chapter 11: Troubleshoot-
ing or the ECH2O Utility Help File.

3. Once connected to an Em50, either click the
“Download” button on the toolbar, or go to the
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Data Menu and select a download option as
described above. 

4. When saving data, the File Save dialog suggests a
name based on the connected logger’s name and
the time and date. However, you can enter any
name by typing it into the “File name” field. 

5. ECH2O Utility can save your data in several differ-
ent file formats:

• Processed Data Excel File (.xls): Converts
the raw downloaded data into engineering values
appropriate for each sensor type. ECH2O Utility
uses the default conversion equation for each
sensor when converting raw data to processed
data. This is the default file type.

• Raw Data Excel File (.xls): Saves the down-
loaded data as raw data so you can apply custom
data processing. The raw data is separated into
each type for sensors that have multiple mea-
surement types. 

• DataTrac Data File (.dxd): Saves the file in a
format that DataTrac can import.

• Processed Data Text File (.txt): Performs the
same function as a processed Excel file, but the
data is saved as a tab delimited text file instead
of a binary spreadsheet file.

• EchoLink Raw Data (.csv): Saves the data in
the same comma delimited file format as the
older EchoLink software. 
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• Raw Data (.csv): Saves the raw data in the
form downloaded from the logger. 

6. Choose the file format you prefer then click
“Save”. ECH2O Utility will download the data and
create the file. 

NOTE: The DataTrac file format (.dxd) is a useful way to
store data for later manipulation. Each .dxd file contains infor-
mation about the ECH2O logger’s settings, identity, and status
along with the raw data for each sensor. ECH2O Utility will
process a .dxd file into a processed data Excel file, a raw data
Excel file, or a processed text file. This allows you to re-process
your raw data with different settings or file formats as needed.

Erasing Data
If you need to erase the data on your Em50, go to
Data > Erase Stored Data. You should erase your data
if you change the Em50’s configuration settings, such
as what type of sensor is in each port. After selecting
the Erase option, you will be asked if you want to con-
tinue. Click Cancel to return to the program, or Erase
Data to continue. 

WARNING! Once this feature is activated, ALL
stored data will be erased and cannot be recov-
ered! 

Instantaneous Measurements (Scan)
The ECH2O Utility gives you the ability to take real-
time sensor measurements with your Em50 logger.
This is most useful as a troubleshooting feature to test
if a sensor is reading properly. You can also see how
sensors react to environmental changes. To take this
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type of reading:

1. Click the “Scan” button in the toolbar, or go to
Actions > Scan Logger Ports. The Em50 will take
a reading on each of the ports, then display a
screen similar to the one below.

2. All 5 ports are displayed, along with the measure-
ment for each port in the units appropriate for the 
sensor. You can change measurement units in the 
Preferences Menu (see “Measurement Units” in 
Chapter 5). Click the sensor’s name to see the 
reading as raw data.

The five ports are displayed, along with the measure-
ment for each port in the current selected unit. If
nothing is plugged in to a port, the reading for that
port will be zero.
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NOTE: Data measured with the scan function will not be
stored in the Em50.
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5. ECH2O Utility Menus

The ECH2O Utility features six menus that allow you
to access the program’s features. This chapter dis-
cusses the features of each menu.

The File Menu

Save Settings File
Selecting the “Save Settings File” option from the File
menu will create a data file that contains all of the set-
tings and information associated with the connected
Em50. This feature is useful for transferring logger
configurations between ECH2O Utility and ECH2O
DataTrac. By default, the name of the settings file is
the name of the selected Em50. After naming the file
and selecting where it will be saved, click Save to cre-
ate the file. 

Convert Data File
ECH2O Utility will “process” or convert raw ECH2O
sensor data to processed data. This feature works by
reading a file containing raw data and outputting the
processed data into a different file. You can convert
DataTrac data files (*.dxd) and EchoLink download
files (*.csv or *.txt). Only files saved with ECH2O
Utility, ECH2O Utility Mobile, or EchoLink can be
converted to processed files. You can choose to save
your processed files as an Excel file or text file.
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Edit Menu

The Preferences Menu
The main feature of the Edit Menu is the Preferences
menu. The Preferences menu features four tabs for
navigation: Measurements, Data Files, Communica-
tions, and Application. Below are a list of the most
common tasks that can be performed in each tab.

1. Measurements Tab 

Measurement Units. These are the unit values that will be
displayed when downloaded data are saved as Excel,
processed, or raw data files. ECH2O Utility supports
displaying some measurement data in multiple units.
For example, it allows you to choose degree Celsius or
degree Fahrenheit for temperature sensors. To set
your preferences for measurement units, choose the
“Measurements” tab in the ECH2O Utility Prefer-
ences window. 
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Locate the type of measurement and select a unit from
the drop-down menu next to it. Click “Close” to apply
the changes.

Power Noise Filter. The AC electrical power in your
office or home can add a subtle amount of noise to
the data logger sensor measurements. The logger’s
Power Noise Filter setting is designed to eliminate this
electrical noise that comes from the AC power distri-
bution system. You should set the value of the Power
Noise Filter to match the frequency of the power cycle
where you live. In North America and most of Asia,
this is 60 Hz (the default value). In most of Europe
the electrical frequency is 50 Hz. This feature only
needs to be set once, as the program will automatically
update the filter of each device that it connects to. 

2. Data Files Tab

Column Headers. The column header gives each column
a title corresponding to the port number, measure-
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ment type, and unit. Column headers for saved data
files are turned on by default, and apply only to pro-
cessed and raw MS Excel data, as well as processed
text data. De-select “Include column headers” to turn
off the column headers for these file types.

Setting Date/Time Format for Data Files. You can control
how the date and time values are formatted in the data
file. By default, the time and date are formatted using
the settings in the Windows Regional & Language
Options control panel. You can modify this to display
the date and time in dd/mm/yyyy format with either a
12- or 24-hour clock. To change the format, select an
option from the menu, then click “Close” to apply the
changes. 

3. Communications Tab
The Communications preference tab has items that
control how the serial communication works between
ECH2O Utility and your Em50. Generally you should
not adjust these settings unless you are experiencing
problems communicating with your Em50.
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Direct Command Retries. ECH2O Utility automatically
retries commands it sends to your Em50 when there
are errors. For most circumstances, the default retries
work well. If you experience unreliable communica-
tion with your Em50, you can try increasing the Direct
Connect Retries.

Maximum Baud Rate. Set a baud rate lower than the
default 115,200 baud if you consistently experience
serial connection problems. 

Communications Port List. ECH2O Utility is compatible
with most USB-to-Serial adapters. Some models of
USB-to-Serial adapters are not found by the serial port
enumeration feature of ECH2O Utility. If your model
of USB-to-serial adapter is not recognized, enable
“Force find all Communication Ports” in the Prefer-
ences Menu by going to the Communication tab, and
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enabling the check box at the bottom of the screen.
Enabling this option may find other serial ports that
are not available for use by the ECH2O Utility (for
example, modems installed in your computer). 

4. Application Tab

Automatic Internet Version Check. ECH2O Utility will
automatically check for a newer version using Deca-
gons internet version-check engine. When this option
is selected, it will notify you when a newer version is
available if you are running ECH2O Utility, and if your
computer is connected to the internet. You can turn
off the automatic check by un-checking this option.
You can manually check for updates any time using
the “Check for ECH2O Utility Updates” option in the
Help menu. 

Automatic Clock Synchronization. By default, the ECH2O
Utility automatically synchronizes your logger’s date
and time to the time set on your computer. You can
disable this feature by un-checking this option. You
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can also update the date and time in your logger any
time it is connected by selecting Actions > Set Date/
Time. 

Error Log File. The ECH2O Utility keeps a log file of
errors and events. Adding more messages to this file is
useful for troubleshooting. Check this option to add
more error and event messages to the error log. 

Date and Time Display in the ECH2O Utility. You can
control how the date and time for your Em50 is dis-
played in the toolbar status area. By default, the time
and date are formatted using the settings in the Win-
dows Regional & Language Options control panel.
You can modify this to display the date and time in
dd/mm/yyyy format with either a 12- or 24-hour
clock.

Data Menu
The Data menu has three options: Download New
Data, Download All, and Erase Stored Data. For
more information on these functions, please refer to
their respective sections in Chapter 4.

Actions Menu

Connect/Disconnect
Performs the same function as the connect/discon-
nect button in the toolbar. It initiates a data communi-
cation connection between your Em50 and your
computer. You must first connect to your Em50
before downloading data.
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Get Settings
This command retrieves all the port and configuration
settings from your Em50. These settings are automati-
cally collected when you connect to your Em50. You
can use this option to check to make sure your
changes are stored in the Em50. 

Apply Settings
Applies the parameters you changed to your Em50.
This operates just like the Apply button on the main
screen. This option is only available when there are
parameter changes available to send to the Em50. 

Scan Logger Ports
This option allows you to take readings from each
port independent of the others. See the section
“Instantaneous Measurements” in Chapter 4 for
details and procedures.

Set the Date/Time
When you select this action, the ECH2O Utility will
set the Em50’s time and date to be the same as the
time and date on your computer.

Device Tools
The Device Tools submenu contains the following
items:

Test Device Firmware. This option is useful in
determining if you have any firmware (the internal
software that runs the Em50) errors. To initiate a firm-
ware test, select Actions > Device Tools > Test
Device Firmware. This will automatically test the
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integrity of your Em50’s firmware, and report if it
reads as Bad or Good.

Initialize Radio Module. Resets the radio module to
the default setting. This option applies to Em50Rs and
DataStations only. 

Initialize Device. Initializing your Em50 is a form of
a hard reset. ECH2O Utility resets your Em50 and re-
writes all the logger settings. All your measurement
data is erased. This option is useful for troubleshoot-
ing a logger that is not working as expected. 

NOTE: Initializing your Em50 will delete all stored data.
Make sure any data has been downloaded out of the Em50
before initiating a reset. 

Window
The Window Menu contains the Show Terminal com-
mand. The terminal window allows you to directly
enter commands for your Em50, and is mainly used
for troubleshooting and diagnosis.  

Help
The Help Menu allows access to the ECH2O Utility
help file, allows you to check for program and firm-
ware updates, and displays information about your
copy of the ECH2O Utility. 

ECH2O Utility Help
This menu item opens the help file. It contains some
of the information found in this manual. 
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Send Feedback to Decagon
This menu item helps you send product feedback, bug
reports, or feature requests to Decagon. Your com-
puter must be connected to the internet for this fea-
ture to work. See Appendix B for more information.

Check for Utility Updates
This function checks for the newest available version
of the ECH2O Utility. Make sure you are connected to
the internet, then select Help > Check for ECH2O
Utility Updates. The program will check to see if there
is a newer version available. If there is, it will direct you
to the web page where you can download it. To check
for a newer version of the ECH2O Utility, choose this
menu item. Checking for updates for the ECH2O
Utility uses Decagon's version-check web engine. Your
computer must be connected to the internet for this
feature to work.

Check for Device Firmware Updates
This menu item is only available when you are con-
nected to an Em50 (or other ECH2O device). It com-
pares the firmware version of your Em50 with the
latest version available from Decagon. You can down-
load a firmware updater when a new version is avail-
able. Your computer must be connected to the
internet for this feature to work. 

About the ECH2O Utility
This menu item opens the “About” window. You can
see the version of your copy of ECH2O Utility here.
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6. ECH2O Radio
Telemetry            

This chapter gives you a brief overview of the radio
telemetry available in the ECH2O system. This infor-
mation only applies to Em50R. The ECH2O system
supports two types of radio telemetry: “Two-way”
modes and “Transmit” modes. Consider one or both
types of radio modes when designing your ECH2O
telemetry system.

ECH2O telemetry networks require each remote radio
logger to have a unique name. Each logger leaves the
factory with the name set to the logger’s unique serial
number. You can easily change the name of the logger
to help you identify or organize your data. You should
not give two loggers the same name. Two loggers with
the same name will interfere with each other when
communicating over the radio.

Two-way Radio Telemetry
The Two-way Telemetry Mode lets you establish a
two-way connection with a remote radio logger. Once
connected to the remote logger, you can download
data and change most settings just like you were con-
nected directly to the logger with a serial cable. Com-
municating with a remote radio logger requires you to



Em50/Em50R Operator’s Manual
6. ECH2O Radio Telemetry

35

have a Rm1 radio modem connected to your com-
puter. Connecting to the remote radio logger happens
through the Rm1.

When a logger is in a Two-way Radio Mode, it turns
on its radio every 45 seconds. While the radio is on,
the logger listens for connection attempts from a
Rm1. If the logger doesn’t hear any connection
attempts, it turns off the radio. If the logger hears a
connection attempt, it leaves the radio on for several
seconds listening for login commands from ECH2O
Utility. It takes up to 60 seconds to connect to the
remote logger.

When you are finished interacting with the remote
radio logger, you press the disconnect button. ECH2O
Utility sends a “logout” command to the remote log-
ger to indicate the end of the communication session.
When the remote logger hears the “logout” com-
mand, it waits for 10 minutes before listening for addi-
tional connection attempts via the radio (you can
always direct connect to your logger). This allows you
to connect to other loggers with the same radio set-
tings. Otherwise, the first logger you contacted may
reconnect. This would prevent you from connecting
to your other loggers.

The Two-way modes generally consume the most
power. The Em50R is designed to work for several
months in the Two-way modes.
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Two-way Radio Modes

Use the Radio settings section of ECH2O Utility to
choose one of the following radio modes that support
two-way communication.

Two-way 24-hour: The radio logger listens for con-
nection attempts every 45 seconds, 24 hours a day.

Two-way 6:00-18:00: The radio logger listens for
connection attempts every 45 seconds between 6 AM
and 6 PM. The logger doesn’t use the radio between 6
PM and 6 AM to conserve battery power, by not lis-
tening for connection attempts during the night.

Transmit + Two-way and CD Transmit + Two-
way: These modes combine the Two-way Radio
modes and the   Transmit Radio modes. You could use
these modes while configuring and testing your radio
network. You should not leave your radio logger in
these modes because they use the most battery power
of all the radio modes.

NOTE: Using Transmit + Two-way and CD Transmit +
Two-way radio modes with the wake interval set to 1 or 2 will
cause the batteries of your logger to drain very rapidly.

Two-way Best Practices

Two-way modes are most useful when you have a
small number (one, two, or three) of remote radio log-
gers you wish to contact. If you have three or more
loggers installed within radio range of each other, con-
sider using one of the Transmit modes. The Two-way
modes also allow you to mount an Rm1 in your vehi-
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cle and interact with the remote logger while in radio
range.

See Chapter 7: Connecting via a Radio Modem for
step by step instructions for establishing a two-way
connection with a remote radio logger.

Transmit Radio Telemetry
The Transmit Radio modes help you create a simple
network of remote radio loggers all transmitting data
to a DataStation radio base station. The DataStation
stores data from all the remote loggers in one conve-
nient place. Typically, a DataStation is connected to
your computer where you can easily download the
data for use in ECH2O DataTrac. Unlike the Two-way
Radio modes, you can’t remotely change logger set-
tings when using this mode.

When a logger is in Transmit mode, it only turns on
the radio when it has new data to broadcast. For
example, when you set the measurement interval in
your logger to 60 minutes, the logger stores your data
every hour and then broadcasts the data to a listening
DataStation. The actual transmit time is randomly
delayed for several minutes to prevent two or more
radio loggers from interfering with each other. 

The Transmit radio modes use less battery power
because the radio is off most of the time. The Em50R
is designed to work for many months in Transmit
mode.
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NOTE: A DataStation is a receiver. It doesn’t cause the
remote logger to send data. If your DataStation is powered off
for some time, it won’t receive data sent by the remote loggers.
However, the missing data is still stored in the logger.  You can
directly connect to the logger to download the missing data.

Transmit Radio Modes

Use the Radio Tab in the logger settings form to
choose one of the following radio modes that support
Transmit communication.

Confirmed Delivery Transmit: This is the most
robust Transmit radio mode. The radio logger adds a
checksum to the data packet before broadcasting the
data to a DataStation. The logger then waits for the
DataStation to confirm it correctly received the data
packet. If the logger doesn’t hear the confirmation, it
retries sending the packet again. The logger stops try-
ing to transmit to a DataStation after 25 attempts.

Transmit Only: This is the original Transmit radio
mode. It doesn’t offer the advantages of the Con-
firmed Delivery Transmit mode. You should use the
Confirmed Delivery mode when possible. Em5R (dis-
continued) loggers only support this Transmit radio
mode.

Transmit + Two-way and CD Transmit + Two-
way: These modes combine the Two-way Radio mode
and the Transmit Radio mode. You could use these
modes while configuring and testing your radio net-
work. You should not leave your radio logger in these
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modes because they use the most battery power of all
the radio modes. Using Transmit + Two-way and CD
Transmit + Two-way radio modes with the wake inter-
val set to 1 or 2 will cause the batteries of your logger
to drain very rapidly.

Transmit Best Practices

Transmit modes are most useful when you have three
or more loggers installed within radio range of each
other. There is no set limit to the number of radio log-
gers broadcasting to a DataStation. Use this mode for
as few as one logger and as many as 50 or more log-
gers. You should use the Telemetry Test feature of
ECH2O Utility to test the connection from your log-
ger to the DataStation.

NOTE: Em50R loggers must have firmware version 1.12 or
later to enable the Confirmed Delivery Transmit mode and
Telemetry Test feature. Your DataStation must have firmware
version 1.09 or later to receive Confirmed Delivery Transmit
mode data packets. Contact Decagon for an application note
that covers the steps needed to upgrade your hardware.

See Chapter 8: DataStation Networks for step by step
instructions for configuring your DataStation and
remote radio loggers.

Radio Settings
For two radio devices to communicate they must
share the same radio settings. An Rm1 radio modem
can only connect to a remote radio logger with the
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same radio settings. A DataStation will only receive
data from loggers with the same radio settings as the
DataStation. Set the Radio Channel to the same value
for all the devices on the same network. Set the Radio
Sub Channel to the same value for all the devices on
the same network.

Radio logger networks with different values set for the
Radio Channel use different frequency-hopping
sequences, and therefore experience minimal interfer-
ence between groups. Radio logger networks with the
same Radio Channel value but different Radio Sub
Channel values can interfere with each other, but can’t
communicate with each other. This interference can
also cause additional battery drain in the radio logger.

The default values for Radio Channel and Sub Chan-
nel are zero. Use  ECH2O Utility to choose other val-
ues.

Radio Performance
The maximum range of the radio modules in the radio
logger and DataStation are effected by the environ-
ment, installation method, and antenna choice. Maxi-
mizing the range of your radio network requires you to
consider all of these factors.

Buildings, hills, vegetation, vehicles and other
environmental obstructions will shorten the radio’s
range – sometimes drastically. You should ensure a
clear, open path between radio devices. Also, radio fre-
quency (RF) interference in the environment around
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the radio can reduce the usable range (even if not
using the same radio frequencies). You should con-
sider nearby growing vegetation when designing and
testing your radio network. Some radio networks work
fine when the vegetation is sparse, yet may fail when
vegetation is full.

You can increase the effective transmit range by
maximizing the height above ground of the radio
antenna. This helps ensure a clear path for the radio
signals and reduces the amount of signal absorbed by
the earth. Use an antenna extension cable to help you
position your antenna when it isn’t practical to install
your logger higher off the ground. If you mount your
radio logger to a metal pole, you should mount your
antenna to the top of the metal pole so it is free to
radiate the signal above the pole.

Replacing the stock antenna on your radio device with
a high-gain antenna can greatly increase the radio
range. Consider using a directional Yagi antenna or a
high-gain omni-directional antenna when you want to
extend the range of your radio network. A high-gain
antenna can also help overcome the effects of
unavoidable environmental obstructions.

The ECH2O telemetry system also supports a simple
relay for use with Transmit Mode networks. Combin-
ing a relay and high-gain antennas allows radio devices
to communicate over very long distances. Contact
Decagon for more information on using a relay in
your radio network.
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7. Connecting via Radio
Modem

Connecting to a radio logger via an Rm1 requires a
few steps different from Direct Connecting to a log-
ger. You should keep notes concerning the logger
name and radio settings to make the rest of the system
configuration easier to accomplish. First, configure
your radio logger to listen for two-way connection
attempts.

Direct connect to a radio logger to set the device’s
radio settings. After establishing a connection,  the
Channel, Sub Channel, and Radio Mode can be set.
The Channel can be set from 0 to 6 inclusive (default
is 0). The Sub Channel can be set from 0 to 65534
inclusive (default is 0). To use the radio logger with an
Rm1, the Radio Mode has to be set to one of the Two-
way modes.

If the Two-way 6:00-18:00 mode is chosen, then
connection via the Rm1 can only take place between
the hours of 6:00 AM through 6:00 PM. This mode
was designed to improve battery life by not keeping
the radio on constantly. The other Two-way modes
can be connected to 24 hours a day. 

After setting the Radio Mode, click the “Apply” but-
ton in ECH2O Utility. Disconnect from the radio log-
ger.
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Connect your computer to the Rm1 by using a stan-
dard 9-pin serial cable. (A USB version of the RM1 is
also available)

Configure ECH2O Utility to connect to your remote
radio logger. Choose the correct communication port
in the “Connect Via” drop-down menu. For example,
if your Rm1 is physically connected to your computers
COM1 communication port, you would choose “Rm1
on COM1 Communication Port” in the “Connect
Via” menu. Click the “Connect” button.

The Logger Query Configuration form will appear. To
connect to a specific logger, type the logger’s Name,
Channel, and Sub Channel. After typing the name,
click the Query button. Leave the Name field blank to
connect to any logger listening on a radio Channel/
Sub Channel.
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NOTE: To connect to a radio logger, the radio Channel setting
must be the same for both the logger and the Rm1. The radio
Sub Channel setting must also be the same for both the logger
and the Rm1.

The Connection Progress screen appears as ECH2O
Utility tries to establish a radio connection with the
remote logger through the Rm1. The connection
process can take up to 60 seconds while ECH2O Util-
ity sends a logger “wake up” signal and retries the con-
nection attempt.

When ECH2O Utility  connects to a remote radio log-
ger, it shows the signal strength of the connection with
the radio signal strength icon on the status bar. Click
on the radio signal strength icon to see the signal
strength percent in the message area.

See Chapter 11: Troubleshooting if ECH2O Utility
fails to connect to your remote logger.

Once ECH2O Utility establishes a two-way radio con-
nection with a remote logger, you can interact with the
logger just like a direct connection.

NOTE: You cannot change the radio Channel or radio Sub
Channel settings in the remote logger while connected via the
Rm1.
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8. DataStation Networks

Configure a DataStation 
Direct Connect to a DataStation to set the radio set-
tings. After establishing a connection set the Channel
and Sub Channel. Channel can be set from 0 to 6
inclusive (default is 0). The Sub Channel can be set
from 0 to 65534 inclusive (default is 0). 

Note the Channel and Sub Channel settings chosen.
Click the “Apply” button to save the settings to the
DataStation. Disconnect from the DataStation. 

Configure a Radio Logger
To use one or more radio loggers with a DataStation
the Radio Mode has to be set to one of the Transmit
modes.

Direct connect to a radio logger. Set the radio Channel
and Sub Channel settings to exactly the values chosen
for the DataStation previously. Set the Radio Mode to
Confirmed Delivery Transmit. This mode provides a
method for confirming the delivery of the data which
greatly increases the ability of the system to success-
fully transfer the data. The Transmit + Two-way
modes are there for use as troubleshooting aids. 

After setting the Radio Mode, click the “Apply” but-
ton.



Em50/Em50R Operator’s Manual
8. DataStation Networks

46

Note: ECH2O Utility only shows the radio modes compatible
with your radio logger model and firmware version. If you don’t
see the “Confirmed Delivery Transmit” radio mode option, then
your radio logger may not support this option. If you are using
an Em50R logger you will need to update the firmware to ver-
sion 1.12 or newer. If you are using an Em5R logger, you will
need to choose the “Transmit Only” radio mode as the Em5R
doesn’t support the Confirmed Delivery Transmit option. 

Telemetry Test 

The Telemetry Test allows you to verify the radio
connection between the radio logger and the DataSta-
tion. Choose “Telemetry Test” from the Actions
Menu.

Click the Test button and the test will begin. When the
test has finished you will be presented with the results
of the test.
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You may have to relocate the radio logger while doing
the Telemetry Test in order to find the best connec-
tion quality. Once you have found the radio logger
location that provides the best connection quality,
install the radio logger at that location. Disconnect
from the radio logger.

NOTE: Telemetry Test only works with Em50 loggers run-
ning firmware 1.12 or newer.

Download Collected Data
After the DataStation has collected data, you can
retrieve the data for permanent storage and analysis.
Start the ECH2O Utility program.

Click the “connect” button to connect to the DataSta-
tion.

Click the “Download New Data” button. The Down-
loading DataStation Data screen will appear and pro-
vides a progress bar displaying the download progress.

Data Processing
ECH2O Data Trac is the most convenient software to
use with a DataStation. DataTrac automatically sorts
the data collected by the DataStation and associates
the data with the correct logger.

ECH2O Utility gives you several choices for the file
type when downloading data from a DataStation. See
Chapter 5: Using ECH2O Utility, for more informa-
tion. If you choose processed or raw data file formats,
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ECH2O Utility walks you through processing the data
for each logger it recorded data for. It prompts you for
the logger type and sensor types for each logger. This
information is necessary for ECH2O Utility to process
the data correctly.
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9. Compatible Sensors    

The Em50 logger is only compatible with sensors
made by Decagon. This chapter gives a brief    descrip-
tion of each sensor’s function. For more information
on each of the described probes, please see that
probe’s respective operator’s manual.

ECH2O Utility normally converts the raw data
recorded by the Em50 into engineering units
appropriate for the sensor when downloading data.
ECH2O Utility uses the default conversion equations
for each sensor and does not support user-specific
calibration. You can choose to download your data in
raw format with ECH2O Utility (see Chapter 4: Using
ECH2O Utility).

Once you have obtained your raw data, you can use a
spreadsheet program to apply your own calibration or
conversion equations. This chapter lists the default
conversion equations for each sensor type. Use these
equations as a starting point for your own custom
equations.

EC-10, EC-20, EC-5, EC-TM and
ECH2O-TE Soil Moisture Sensors
The ECH2O EC-5, 10, and 20 probes measure the
dielectric constant of the soil to determine the
volumetric water content of the soil. Since the dielec-
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tric constant of water is much higher than that of air
or soil minerals, the dielectric constant of the soil is a
sensitive measure of water content. The ECH2O-TE
is designed to measure the water content, electrical
conductivity, and temperature of growing media and
soil. The ECH2O EC-TM is the same design as the
ECH2O-TE and measures water content and temper-
ature. All ECH2O probes have a very low power
requirement and high resolution. 

Choosing a Soil Moisture Probe

The table below can help you decide which ECH2O
probe is right for your measurement needs. Each
probe model offers different trade-offs with features
and sample size. 

NOTE: This table compares the ECH2O models that are
compatible with the Em50. For a comparison including other
ECH2O probe models, visit www.ech2o.com.
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* Only the rockwool calibration will read up to 100%. Other
calibration equations have been linearized and optimized for low
and moderate water contents, and will not read 100% in water.

Default Conversion Equations 
ECH2O Utility uses mineral soil equations for the
ECH2O probes. ECH2O DataTrac offers conversion
equations for potting soil, rockwool, and custom
calibration.

EC-5:
Mineral Soil: θ = 0.00085 * RAW - 0.481
Potting Soil: θ = 0.00072 * RAW - 0.393
Rockwool: 
θ  = 6.28x10-7 * RAW2 + 1.37x10-4 * RAW - 0.183

EC-5 EC-10 EC-20 TE/TM
Water 

content 
measurement 

range

0-100%* 0-40% 0-40% 0-100%*

Low cost Best Best Best Good
Accuracy in 

high EC
High Low Low High

Accuracy in 
variety of 
textures

Best Good Good Best

Use in pots & 
greenhouses

Best Good Fair Best

Large sample 
sizes

Fair Good Best Fair
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EC-10:
Mineral Soil: θ = 0.000571 * RAW - 0.376 

EC-20:
Mineral Soil: θ = 0.000424 * RAW - 0.29 

ECH2O-TE/EC-TM:
Mineral soil: θ = 0.00109 * RAWθ  - 0.629
Potting soil: θ = 0.00104 * RAWθ  - 0.499
Rockwool: 
θ = 5.15 x 10-8 * RAWθ

2 + 0.000141 * RAWθ - 0.16

The ECH2O-TE sensor also measures temperature
and electrical conductivity. ECH2O Utility saves the
raw values for these measurements in their own data
column. 

°C = (RAWT - 400)/10
Bulk EC dS/m = RAWEC/100

The ECH2O probes can be used with any port on the
Em50.

ECT Temperature Sensor
The ECH2O Temperature sensor is for use in soil or
in the air. It can be connected directly to any channel
in the Em50 or Em50R for long-term monitoring of
temperature. If you are using the ECH2O Tempera-
ture sensor in air, we strongly recommend that you use
it in a radiation shield. Decagon has a radiation shield
that can be used with the ECT. If you would like to
purchase one, please contact us.
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Default Conversion Equation
The default conversion equation for the ECT first cal-
culates an intermediate value with a log transform
(natural log), then the temperature in °C from a 3rd-
order polynomial: 

This equation offers 0.5 °C accuracy in the range of
-40° C to + 60° C. 

The ECT temperature sensor can be used with any
port on the Em50.

ECRN-50 and ECRN-100
Rain Gauges
The ECRN-50 and ECRN-100 are simple self-empty-
ing electronic rain gauges. They are made of durable,
weather-resistant plastic that is UV-resistant. 

The ECRN-50 is best used for measuring irrigation
events. This sensor has a resolution of 1 mm. You can
configure the Em50 to treat the data collected by the
ECRN-50 as standard precipitation or as volume data.
Configured as volume gauges, they are useful for mea-
suring the output of irrigation systems in terms of gal-
lons (or liters) per hour

x
4095
RAW
------------- 
  1– 
 ln=

C 25.02 x 22.84– x 1.532 0.08372x–( )+( )+( )+=°
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The ECRN-100 is a standard 0.01 inch rain gauge. It is
best used for measuring rain fall.

NOTE: The older model ECRN Rain Gauge used with
Em5 loggers is not compatible with the Em50. Please contact
Decagon for an ECRN upgrade kit that will allow you to use it
with the Em50. 

Default Conversion Equations
The Em50 uses an accumulating counter for storing
rain gauge tip events. To calculate the number of tips
for one time interval (interval n), you compare it to the
previous interval (interval n-1).

tips = RAWn - RAWn-1     for RAWn > RAWn-1 
tips = RAWn     for RAWn-1 = 0

ECRN-50 precipitation is 1 mm per tip; volume is 5
mL per tip.

ECRN-100 precipitation is 0.01 in. per tip.

The ECRN-50 and ECRN-100 can be used with any
port on the Em50.

G1 Drain Gauge
Decagon’s Drain Gauge is an instrument that is
designed for long-term monitoring of water move-
ment and chemical leaching below the root zone.
Select “G1 Drain Gauge” when configuring the probe
in the ECH2O Utility and DataTrac.

Default Conversion Equation
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The Drain Gauge contains a tip reservoir and a water
level sensor. When the reservoir fills and auto-siphons,
the level sensor records that data as a tip (1mm per
tip). The Em50 records the level of the tip reservoir as
fractions of a tip (fractions of a mm). The Em50 uses
an accumulating counter to store Drain Gauge tips. To
calculate the number of tips for one time interval
(interval n), you compare it to the previous interval
(interval n-1). 
raw tips = RAWn - RAWn-1 for RAWn > RAWn-1
raw tips = RAWn for  RAWn-1 = 0

tips (mm) = raw tips/10

Em50 firmware version 1.10 and newer also record
the raw analog output of the level sensor at the
measurement interval. This raw output is useful for
troubleshooting Drain Gauge problems. ECH2O Util-
ity automatically adds a column for raw data if your
Em50 supports this additional data type. 

The ECRN-50 can be used with any port on the
Em50.

PYR Solar Radiation Sensor
The PYR Solar Radiation Sensor (pyronometer) mea-
sures solar radiation in W/m2. This sensor features a
self-cleaning dome-shaped head which prevents water
accumulation and is designed for continuous outdoor
use. Small changes in the level of the PYR sensor can
also cause large measurement errors. Make sure that
the top of the domed sensor body is kept horizontal.
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Use the included leveling plate to ensure the sensor is
level.

NOTE: You must have Em50 firmware 1.12 or newer to cor-
rectly measure the PYR sensor.

Default Conversion Equation
W/m2 = RAW * (1500/4096) * 5.0

The PYR Solar Radiation sensor can be used in any
port on the Em50.

PS-1 Pressure Switch 
The ECH2O PS-1 Pressure Switch monitors whether
a pressurized irrigation system is either on or off,
using a minimum pressure of 5 p.s.i. Growers keeping
tabs on crop irrigation, for example, would insert the
pressure switch into a pipe in the system, and connect
the pressure switch to the Em50. The pressure switch
then displays an ON or OFF value in ECH2O Utility.
If the water flow is above 5 p.s.i., the switch records
ON; but if it is lower, the switch records OFF. This
allows the user to monitor whether or not the irriga-
tion system has been running for a desired time inter-
val.     

Deafult Conversion Equation
The Em50 uses an accumulating counter for storing
PS-1 Pressure Switch events. The pressure switch
records the time the switch is actuated during the mea-
surement interval. The time resolution is 1 minute.
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To calculate the amount of time the switch is actuated
for one time interval (interval n), you compare it to the
previous interval (interval n-1).

minutes = RAWn - RAWn-1   for RAWn > RAWn-1
minutes = RAWn                    for RAWn-1 = 0

The PS-1 Pressure Switch can be used with any port
on the Em50. 

NOTE: You must have Em50 firmware version 1.10 or
higher to use the pressure switch. 

EHT Temperature/RH Sensor
The ECH2O Temperature/RH sensor is a digital sen-
sor designed to measure temperature and relative
humidity. Select “EHT RH/Temp” when configuring
the probe in the ECH2O Utility.

ECH2O Utility saves the raw data for temperature and
humidity in their own data columns. 

Temp (°C) = 0.040 * RAWT - 39.55
RH = 0.01 * (-4.0 + RAWRH  *  (0.648-0.00072 *
RAWRH) + (Temp-25.0) * (0.01 + .00128 * RAWRH))
 
NOTE: The RH from this equation will be in decimal form.
Multiply the result by 100 to get the RH percentage.. 

The ECH2O Temperature/RH sensor can be used
with any port on the Em50. 
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Millivolt Sensor
Many of the above analog sensors can also be read in
millivolt mode. For example, if an EC-5 soil moisture
sensor is connected and you wanted to see the
millivolt output in processed data files, you would
specify that port as having a Millivolt Sensor
connected. 

NOTE: This only works with analog sensors, not digital sen-
sors such as the ECH2O-TE, EC-TM, or Temperature/RH
sensor. 

Default Conversion Equation
millivolts = RAW * (3000/4096)                       

LWS Leaf Wetness Sensor
The Leaf Wetness Sensor measures surface wetness by
measuring the dielectric constant of a zone of influ-
ence on its upper surface. This sensor also has very
high resolution, which gives you the ability to detect
very small amounts of water (or ice) on the sensor sur-
face. The sensor does not need to be painted before
use, which eliminates the need for individual sensor
calibration. Select “ELW Leaf Wetness” when config-
uring the probe in the ECH2O Utility.

The Em50 firmware automatically records the number
of minutes the LWS sensor is above the 450 and 460
threshold values. The Em50 also records a single   ana-
log raw value at the measurement interval. The raw
data download puts each of these measurement types
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in a single column. The Em50 uses an accumulating
counter to store the number of minutes for each 
threshold. To calculate the number of minutes the
LWS was wet for one time interval (interval n), you
compare it to the previous interval (interval n-1). 

minutes = RAWn - RAWn-1     for RAWn > RAWn-1

minutes = (2048 - RAWn-1) + RAWn     for RAWn <
RAWn-1

The LWS Leaf Wetness sensor can be used with any
port on the Em50.



Em50/Em50R Operator’s Manual
10. Caring for the Em50

60

10. Caring for the Em50 

Replacing the Batteries
If installed correctly, the Em50 requires little
maintenance. The main requirement is that batteries
need to be replaced when their charge becomes too
low. When the battery life indicator in ECH2O Utility
shows your Em50’s batteries are less than 5%, you
need to replace them.

NOTE: Installing or changing the batteries in your
Em50 resets the internal real-time clock. You must
connect to your Em50 using any ECH2O system soft-
ware to reset the logger’s clock. If you don’t set the
logger’s clock, the time and date associated with each
measurement will be incorrect.

Long-Term Maintenance
When caring for the Em50 over an extended period of
time, be sure to do the following periodically:

1. Check the battery holders and make sure they are
clean and free of corrosion.

2. Check that the sensor ports are clean, and that the
sensors are making good contact with the ports.

3. Check case gaskets and sensor cable strain relief. 
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11. Troubleshooting 

Although the Em50 has been designed for durability
and built to the highest manufacturing standards,
problems may occasionally occur. This chapter details
the most common problems that you may encounter,
and their solutions. If you have a problem not
described here or that this section cannot remedy,
contact Decagon. 

Troubleshooting Serial Ports
PROBLEM: The ECH2O Utility tells me the com-
munication port I want to use is in use by another
application, but I don’t think any other programs are
running. 

SOLUTION: Some PDA synchronization programs
monitor serial communication ports. Disable
Microsoft’s ActiveSync or Palm’s HotSync system
software while trying to use the serial port with the
ECH2O Utility. 

PROBLEM: My USB to Serial adapter is not showing
in the communication port picker. 

SOLUTION: Enable “Force find all Communication
Ports” in the Preferences Menu by going to the Edit
Menu, clicking Preferences, then the Communication
tab, and enabling the check box at the bottom of the
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screen. Enabling this option may find other serial
ports that are not available for use by the ECH2O
Utility (for example, modems installed in your com-
puter). 

Troubleshooting Direct
Connection
PROBLEM: ECH2O Utility tells me it can’t connect
to my device.

SOLUTION: Try one or more of the following to
make sure there is a serial connection to the ECH2O
device:

Check your serial port choice. Make sure the “Connect
Via” drop-down menu shows the name of the serial
port you are using to physically connect to your logger
or DataStation. For example, if our logger is physically
connected to COM1, the “Connect Via” control
should be set to “Direct on COM1 Communication
Port”.

Check that your serial cable is securely plugged into
your logger or DataStation and your Computer.

Make sure your logger has good batteries or your
DataStation is plugged in. Try pressing the reset but-
ton on your logger or DataStation.

NOTE: Serial Cables can fail. If you suspect your serial cable
may be the problem, try connecting to a second logger. If you can
connect, the problem is probably the first logger. If you can’t con-
nect to the second logger either, the problem may be your cable.
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Try using a spare Decagon Serial Cable Adapter if you are
having trouble connecting to a logger.

PROBLEM: ECH2O Utility keeps reporting it lost
the connection to my device.

SOLUTION: This rarely happens for a direct con-
nection. Please check or replace your serial cables. You
can also increase the number of times ECH2O Utility
tries sending commands to the logger or DataStation.
Increase the Direct Connect Retries on the Communi-
cation tab of the Preferences form.

Troubleshooting Radio
Connections
PROBLEM: ECH2O Utility tells me my radio
modem isn’t responding.

SOLUTION: Make sure your serial cable is securely
attached to your computer and your Rm1. Your Rm1
should have power and be turned on.

PROBLEM: ECH2O Utility tells me it can’t connect
to my radio logger when I’m using an Rm1.

SOLUTION: Try one or more of the following to
make sure there is a good radio connection to your
remote logger:

• Make sure you are within radio range of the
remote logger. Increase the radio signal strength
to your logger by moving closer to your logger
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or using a high-gain antenna to see if you can
establish a radio connection.

• Make sure the antenna on the logger and the
Rm1 are securely fastened to the radio module.

• Check the Radio Channel and the Radio Sub
Channel settings you are using on your remote
loggers and Rm1. See Chapter 7, Connecting via
a Radio Modem, for how to configure your
radio settings.

• Make sure you wait ten minutes between con-
nection attempts for the same logger. If you just
disconnected from a logger, you must wait for
ten minutes before that logger will accept radio
connections (you can always direct connect to
your logger).

• Make sure your logger has good batteries. Try
pressing the reset button on your logger.

PROBLEM: ECH2O Utility keeps reporting it lost
the connection to my device.

SOLUTION: This can happen when the radio con-
nection is lost. Try increasing the radio signal strength
by moving closer to the remote logger or using a high-
gain antenna. You can also increase the number of
times ECH2O Utility tries sending commands to the
logger. Increase the Radio Connect Retries in the
Communications tab on the Preferences form.
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Troubleshooting Data Issues

PROBLEM: ECH2O Utility tells me there is no new
data for downloading.

SOLUTION: Make sure the logger is configured to
measure data. Make sure the measurement interval is
set to a number greater than zero. Try pressing the
reset button if the logger does have a non-zero mea-
surement interval.

PROBLEM: My sensor data shows “* * *” in the
Scan window.

SOLUTION: The three asterisks mean the raw data
measured by the logger is out of expected range for
the sensor. This could be caused by a broken sensor.
Make sure the sensor is fully inserted into the logger’s
sensor port. Make sure the sensor type shown in the
Scan window matches the sensor actually connected
to your logger.

PROBLEM: My sensor data doesn’t seem correct.

SOLUTION: There are many issues that affect the
quality of the sensor measurement. Please see the user
manual for your particular sensor for help trouble-
shooting your the data collected by your sensor.

Troubleshooting Logger Issues
PROBLEM: My logger stopped making measure-
ments.
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SOLUTION: Make sure the measurement interval is
not set to 0. The Em50 does not make any measure-
ments when the measurement interval is set to zero.

Try pushing the reset button. Try initializing your
Em50 if a reset isn’t enough to get the logger measur-
ing sensors again. Connect to the logger and choose
“Initialize Device...” from the Device Tools sub-menu
in the Actions menu. Initializing your Em50 will erase
any stored data so you should download any data you
want to keep before choosing this option.

PROBLEM: My logger doesn’t seem to be working
correctly or reliably.

SOLUTION: Try pressing the reset button on the
logger. This resets the logger’s firmware. You can also
try connecting to the logger and testing the integrity
of the firmware. Choose “Test Device Firmware”
from the Device Tools menu of the Actions menu.
Contact Decagon for help reloading the firmware if
ECH2O Utility reports the device firmware is corrupt.
If the firmware tests good and your logger is still not
working correctly, please contact Decagon for repair
or replacement.
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Appendix A:

Em50 CE Compliance               

Application of Council Directive: 89/336/EEC

Standards to Which EN61326 : 1998
Conformity is Declared: EN55022 : 1998

Manufacturer’s Name:            Decagon Devices, Inc.
                                                    2365 NE Hopkins Ct
                                                    Pullman, WA 99163

Type of Equipment:                Data collection system

Model Number: Em50

Year of First Manufacture:                                   2002

This is to certify that the Em50, manufactured by
Decagon Devices, Inc., a corporation based in Pull-
man, Washington, USA meets or exceeds the stan-
dards for CE compliance as per the Council Directives
noted above. All instruments are built at the factory at
Decagon and pertinent testing documentation is freely
available for verification.   
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Em50R/DataStation /Rm1 CE 
Compliance 

Application of Council Directive: 89/336/EEC

Standards to Which EN61326 : 1998
Conformity is Declared: EN55022 : 1998

Manufacturer’s Name:            Decagon Devices, Inc.
                                                    2365 NE Hopkins Ct
                                                    Pullman, WA 99163

Type of Equipment:                Data collection system

Model Number: Em50R 2.4 GHz, Rm1 2.4 GHz,
DataStation 2.4 GHz

Year of First Manufacture:                                   2002

Restrictions:
France: Current regulations in France stipulate that
these devices may be used indoors only. Outdoor use
on private property is subject to authorization from
the French Telecommunications Regulatory Authority.
Outdoor use on public property is currently prohib-
ited. For more information, see www.ero.dk.
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FCC Compliance

The following FCC statement
applies to the Em50, Em50R,
DataStation, and Rm1.

This device complies with part 15 of the FCC Rules.
Operation is subject to the following conditions:

1. This device may not cause harmful interference.

2. This device must accept any interference received, 
including interference that may cause undesired 
operation.

The Em50R, DataStation, and Rm1 contain one
of the following modules:

FCC ID: OUR9XSTREAM  IC: 4214A-9XSTREAM
FCC ID: OUR-24XSTREAM  IC: 4214A 12008
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Appendix B:

Send Feedback to Decagon

Decagon Software makes it easy to send feedback, bug
reports, and feature requests to Decagon or your
Decagon Distributor. Choose “Send Feedback to
Decagon...” from the help menu. This opens the win-
dow shown below.

Enter your name, company name, and other contact
information. Tell us what type of feedback you are
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sending (General Feedback, Feature Suggestions, Bug
Report, or Other). Indicate how you want us to
respond to your feedback (Email or Telephone).

Use the description area to give details for your feed-
back. If you are reporting a bug, it is very helpful for
you to tell us what steps you took for the bug to hap-
pen and any error message you saw. By default, bug
reports also include the software error files.

You can send Decagon a file using this form too. This
is useful for sending data files that you have questions
about.

If you work directly with a Decagon representative,
put their E-mail address in the field at the bottom of
the form. This sends the contents of the form to
them. Your Decagon representative can follow-up
with you directly.
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